
Adobe Flash Professional Guide
How to work with text
Adobe Flash Professional lets you add text to a Flash application in two formats:

• You can add Text Layout Framework (TLF) text.

• You can add Classic text.

Using the Text Layout Framework

TLF text provides the following enhancements over Classic text:

• You can adjust a wider range of character aspects, such as leading and tracking.

• You can rotate text more easily.

• You can flow text across multiple containers, as it does in a magazine page layout.

• You can better control the attributes of Asian text.

• You can create right-to-left text.

The Text Layout Framework is available as an option in the Properties panel. 

TLF text requires that ActionScript 3.0 and Flash Player 10 or later are specified in the publish settings of your FLA 
file. See the guide “How to publish a Flash document” for more information about publish settings.

To create TLF text:

1. Start Flash and open a new blank document 
(ActionScript 3.0).

2. Click the Text tool.

3. Make sure the Properties panel is open. If not, select 
Window > Properties.

4. Select TLF Text from the Text Engine menu (Figure 1).

5. Move the pointer to the Stage.

The pointer changes to a cross hair with the letter T 
attached to it.

6. Drag to create a container (Figure 2).

7. Release the mouse button and click in the container.

8. Type some text (Figure 3).

Figure 1 Text Engine menu.

Figure 2 Dragging to create a container

Figure 3 Text container
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Managing text flow for TLF text

If you fill a Flash TLF text container with more text than fits within the bounding box, a red plus symbol appears. 
This red plus indicates the text is overset. Overset text is text that does not fit in the container.You can solve the 
problem of overset text by making the container bigger, but often you will want to continue the text in another 
container, either on the same page or on another page. This is called text flow. 

For example, in Figure 4 the upper container is overset and needs to flow to the lower text container.

Figure 4 Overset text

In Figure 5, the two containers have been linked, as indicated by a line between the Out port of the top container and 
the In port of the bottom container.

Figure 5  Linked containers

Out port of text container In port of text container
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To flow text:

1. Use the Selection tool to select a container.

2. Click the Out port in the lower-right corner of the 
selected container.

The pointer changes to the loaded text icon, an arrow 
with small lines of text (Figure 6).

3. Then do one of the following:

• To link to an existing container, position the pointer 
over the target container. The pointer changes to the 
link text icon, an arrow with chain links (Figure 7). 
Click the container to link the two containers.

• To link to a new container, click or drag on an empty 
part of the Stage. Clicking creates an object of the 
same size and shape as the original; dragging lets 
you determine the size of the container.

The containers are now linked and text will flow between 
them (Figure 8).

Figure 6 Loaded text icon

Figure 7 Link text icon

Figure 8 Result of linking to a text container
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Using Classic text

You can specify three types of Classic text in the Properties panel: Static, Dynamic, and Input. The default type is 
Static. Use Static text when the text will not change, such as button and form labels. Use Dynamic text for text that 
will change as the movie plays, such as text pulled from an external database in response to a viewer’s request. Use 
Input text for requesting input from the viewer, such as a user name and password—input text is similar to a form 
field.

To use Classic text:

1. Start Flash and open a new blank document 
(ActionScript 3.0).

2. In the Tools panel, select the Text tool.

3. Make sure the Properties panel is open. If not, select 
Window > Properties.

4. Select Classic Text from the Text Engine menu 
(Figure 9).

5. In the Properties panel, make sure that Static Text is 
selected in the Text Type menu (Figure 9).

6. Move the pointer to the Stage.

The pointer changes to a cross hair with the letter T 
attached to it.

7. To create an expanding-width text field, click on the 
Stage.

The text field contains a flashing insertion point. This is 
where text appears as you type. The round handle 
indicates the text field is an expanding-width one-line 
static text field (Figure 11).

8. Type the text.

The text field expands as you type.

9. Click away from the text to deselect it.

10. To create a fixed-width text field, drag on the Stage to 
create a text box. Make the box about as wide as you 
think is necessary to fit your text.

A text field is created. This text field has a square handle 
in the upper right corner (Figure 12). The square handle 
indicates that the text field is a fixed-width static text 
field.

Figure 9 Text Engine menu

Figure 10 Text Type menu

Figure 11 Expanding-width one-line static text 
field

Figure 12 Fixed-width static text field

Round handle

Square handle
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11. Type the text.

The text you type wraps to a new line when it reaches the 
right edge of the text field.

12. Drag the square handle to the right until the text is on a 
single line.

Note: Double-clicking a square handle changes it to a 
round handle and changes the text field to an expanding-
width one-line static text box.

13. Click away from the text to deselect it.

Formatting both TLF and Classic text

You can apply basic character formatting to TLF or Classic text, such as font family, font type, font style, and font 
color. You can also adjust tracking, adjust leading, and apply anti-aliasing to both formats.

To apply basic formatting to text:

1. Select the Text tool and drag to select some text. Or use 
the Selection tool to select a text container (TLF) or text 
field (Classic). 

2. In the Character section of the Properties panel, choose a 
different font family in the Font Family menu, such as 
Verdana (Figure 13).

3. Choose a different font style, such as italic or bold.

4. Set a different font size, such as 14, by using the Size 
scrubber. (You can also click the scrubber and type a 
value for Size.).

5. Choose a different font color by clicking the Color box 
and doing one of the following:

• Select a color from the Color palette (Figure 14).

• Enter a hexadecimal color value in the upper-left 
corner (Figure 14).

• Click the Color Picker icon and select a color from 
the system color picker. (When setting the text color, 
use only solid colors, not gradients. To apply a 
gradient to text, break the text apart and convert the 
text to its component lines and fills.)

6. In the Paragraph section of the Properties panel, choose 
an alignment for the text, such as left, centered, right, or 
justify.

Note: For TLF text, Flash provides additional Justify 
alignment options for the last line of text, such as Justify 
With Last Line Aligned To Start or Justify With Last Line 
Aligned To Center.

Figure 13 Properties panel, Character section

Figure 14 Color palette

Hexidecimal color 
value

Color Picker icon
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Adjusting leading and tracking

To improve readability and meet design goals, you can adjust the spacing between lines and characters—leading and 
tracking—for both TLF and Classic text.

Adjusting leading

Leading refers to the space between lines. In Classic text, leading is referred to as line spacing. You are probably used 
to differentiating between single-spaced and double-spaced text. By adjusting leading, you can fine-tune the space 
between lines. By default, leading is set to 120% of the text’s height for TLF text and 0 for Classic text. 

To adjust leading:

1. Select the Text tool and drag to select some text. Or use 
the Selection tool to select a text container (TLF) or text 
field (Classic).

2. Do one of the following:

• For TLF text, drag the Leading scrubber in the 
Character section of the Properties panel 
(Figure 15). You can also click the current Leading 
value and enter a new value. 

• For Classic text, drag the Line Spacing scrubber in 
the Paragraph section of the Properties panel 
(Figure 16). You can also click the current Spacing 
value and enter a new value.

The result of decreased leading is less space between 
lines of text. Increasing leading adds more space between 
lines of text (Figure 17).

Figure 15 Properties panel, Character section

Figure 16 Properties panel, Paragraph section

Figure 17 Increased leading
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Adjusting tracking

Tracking refers to the space between characters across a line of text. In Classic text, tracking is referred to as letter 
spacing. You adjust tracking to space the letters further apart or closer together.

To adjust tracking:

1. Select the Text tool and drag to select some text. Or use 
the Selection tool to select a text container (TLF) or text 
field (Classic).

2. Do one of the following:

• For TLF text, drag the Tracking scrubber in the 
Character section of the Properties panel 
(Figure 18). You can also click the current Tracking 
value and enter a new value.

• For Classic text, drag the Letter Spacing scrubber in 
the Character section of the Properties panel 
(Figure 19). You can also click the current Letter 
Spacing value and enter a new value.

The result of decreased tracking is less space between 
characters. Increasing tracking adds more space between 
characters (Figure 20).

Figure 18 Properties panel, Character section

Figure 19 Properties panel, Character section

Figure 20 Increased tracking
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Applying anti-aliasing

Anti-aliasing lets you smooth the edges of on-screen text. Anti-aliasing is especially useful for small font sizes. When 
anti-aliasing is enabled, all text in the current selection is affected. Anti-aliasing operates with text of all point sizes in 
the same way. You can apply anti-aliasing to TLF text or Classic text.

You can select from the following anti-aliasing options:

Use Device Fonts: The SWF file will use fonts installed on the viewer’s computer to display the fonts. This option 
doesn’t increase the size of the SWF file.You should use this option only with commonly installed fonts, such as 
Verdana or Arial.

Readability: Allows for improved legibility of embedded fonts, particularly at small sizes. To use this option, you 
must embed the font. When you embed fonts, Flash copies the font into the SWF file so that the font does not need to 
be present on the viewer’s computer. This increases the size of the SWF file slightly.

Animation: Creates a smoother animation of text by ignoring alignment and kerning information. To use this option, 
you must embed the font. When you embed fonts, Flash copies the font into the SWF file, so that the font does not 
need to be present on the viewer’s computer. This increases the size of the SWF file slightly. Animation anti-aliasing 
will be hard to read if font size is smaller than 10 points.

For Classic text, you can select two additional anti-aliasing options:

Bitmap Text (No Anti-alias): Useful for displaying small font sizes. Bitmap fonts do not contain outlines, which helps 
keep the file size of a published Flash document to a minimum.

Custom Anti-alias: Modify thickness and sharpness to control the effect anti-alias has on your text.

To set anti-aliasing:

1. Select the Text tool and drag to select some text. Or use 
the Selection tool to select a text container (TLF) or text 
field (Classic).

2. Choose an anti-aliasing option, such as Readability, from 
the Anti-Alias menu in the Character section of the 
Properties panel (Figure 21).

Figure 21 Anti-alias menu for TLF text
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Note: The Font Embedding Warning dialog box opens if 
you select Readability or Animation after selecting Use 
Device Fonts (Figure 22). You can click Embed to open 
the Font Embedding dialog box (Figure 23) and select 
which fonts to embed. You can click Not Now to 
continue without embedding fonts.

You can also open the Font Embedding dialog box by 
clicking Embed in the Character section of the Properties 
panel.

Figure 22 Font Embedding Warning dialog box

Figure 23 Font Embedding dialog box

Applying filters to text

To add interest or fulfill other design goals, you can apply graphics filters to both TLF and Classic text in Flash. 
These filters can make text appear to be raised, give text a shadow, or give text a glow. Graphics filters are available 
in the Filters section of the Properties panel.

Applying the Drop Shadow filter to text

The Drop Shadow filter makes it appear that text or an object is casting a shadow.

To add the Drop Shadow filter to text:

1. Use the Selection tool to select a text container (TLF) or 
field (Classic) with text.

Note: You cannot select the text itself to apply the filter.

2. In the Properties panel, display the Filters section 
(Figure 24).

Note: You may need to scroll down in the Properties 
panel to see the Filters section because it's at the bottom 
of the panel.

3. Click the Add Filter button in the lower-left corner of the 
panel.

Figure 24 Properties panel, Filter section

Add Filter button
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4. Select Drop Shadow in the Filters menu (Figure 25).

The text includes a drop shadow (Figure 26).

You can adjust the characteristics of the Drop Shadow, 
such as its color, in the Filters section of the Properties 
panel (Figure 27).

Figure 25 Filters menu

Figure 26 Drop shadow

Figure 27 Drop shadow properties

Other filters

You can apply several other filters to text to create interesting visual effects.

Blur

The Blur filter softens the edges and details of objects. Applying a blur to an object can make it appear to be behind 
other objects, or make an object appear to be in motion. Adjust the amount and direction of blur by using the X and Y 
text boxes.
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Glow

The Glow filter lets you apply a color around the edges of an object.

• Glow: Make the object appear to shine.

• Inner Glow: Apply the glow only within the boundaries of the object.

• Knockout: Remove the object and leave the glow. The object appears outlined in glow.

Bevel

Applying a bevel applies a highlight to the object that makes it appear to be raised above the background surface.

• Inner Bevel: Give the object a three-dimensional look by applying highlights and a shadow to the inside of the 
object.

• Outer Bevel: Give the object a three-dimensional look by applying highlights and a shadow to the outside of the 
object.

• Full Bevel: Apply both inner bevel and outer bevel effects to the object.

You can alter the bevel’s shadow and highlight colors, the type of bevel (inner, outer, or full), its strength, and the 
angle of light that falls on it.

Gradient Glow

Applying a gradient glow produces a glow look with a gradient color across the surface of the glow. The gradient 
glow requires one color at the beginning of the gradient with an Alpha value of 0. You cannot move the position of 
this color, but you can change the color.

Gradient Bevel

Applying a gradient bevel produces a raised look that makes an object appear to be raised above the background, with 
a gradient color across the surface of the bevel. The gradient bevel requires one color in the middle of the gradient 
with an Alpha value of 0.

Adjust color

You can use the Adjust Color filter to finely control the color attributes of the selected object, including contrast, 
brightness, saturation, and hue.

• Brightness: Make the object brighter or darker.

• Contrast: Increase or decrease the distinction between light and dark.

• Saturation: Increase the intensity of color. For example, raising saturation on blue text makes the text a more 
vibrant blue.

• Hue: Increase or decrease the shade of the color.
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